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CasaXPS Processing Software for XPS Spectra 
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NO WARRANTY  
Casa Software Ltd. does its best to ensure the accuracy and reliability of the Software and 

Related Documentation. Nevertheless, the Software and Related Documentation may 

contain errors that may affect its performance to a greater or lesser degree. Therefore no 

representation is made nor warranty given that the Software and Related Documentation 

will be suitable for any particular purpose, or that data or results produced by the 

Software and Related Documentation will be suitable for use under any specific 

conditions, or that the Software and Related Documentation will not contain errors. Casa 

Software Ltd. shall not in any way be liable for any loss consequential, either directly or 

indirectly, upon the existence of errors in the Software and Related Documentation. The 

{ƻŦǘǿŀǊŜ ŀƴŘ wŜƭŀǘŜŘ 5ƻŎǳƳŜƴǘŀǘƛƻƴΣ ƛƴŎƭǳŘƛƴƎ ƛƴǎǘǊǳŎǘƛƻƴǎ ŦƻǊ ƛǘǎ ǳǎŜΣ ƛǎ ǇǊƻǾƛŘŜŘ ά!{ L{έ 

without warranty of any kind. Casa Software Ltd. further disclaims all implied warranties 

including without limitation any implied warranties of merchantability or fitness for a 

particular purpose. CasaXPS should not be relied on for solving a problem whose incorrect 

solution could result in injury to a person or loss of property. The entire risk arising out of 

the use or performance of the Software and Related Documentation remains with the 

Recipient. In no event shall Casa Software Ltd. be liable for any damages whatsoever, 

including without limitation, damages for loss of business profit, business interruption, 

loss of business information or other pecuniary loss, arising out of the use or inability to 

use the Software or written material, even if Casa Software Ltd. has been advised of the 

possibility of such damages. 
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Basics of CasaXPS 

The following is an introduction to the basics of CasaXPS. The intention is to 

provide an overview of the software in terms of displaying and quantifying 

XPS spectra. 

CasaXPS Main Window 

 
The Main Window of CasaXPS is a multiple document interface capable of 

managing large numbers of files all open at the same time.  

Key points: 

 Each file opened in CasaXPS appears in an experiment frame. 

 The top-most experiment frame has mouse focus. 

 An experiment frame is divided into two panes; the left-hand pane 

displays the data in graphical form, while the right-hand pane displays 

the logical structure of the VAMAS file opened in CasaXPS. 

Management of experiment frames is performed using the Window menu on 

the CasaXPS main window. 
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 Experiment frames may appear full sized. 

 
 Experiment frames may be tiled. 

 
 Or as icons within the CasaXPS Main Window. 
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Loading Data into CasaXPS  

CasaXPS converts other data formats to ASCII ISO 14976 (VAMAS) format. 

Data in VAMAS format are opened as experiment frames by selecting the 

VAMAS file via the Open option on the File menu. 

 
A file dialog window allows data to be selected from disk. 

 
Data not in VAMAS format is converted through CasaXPS via the Convert 

option on the File menu. A Convert to VAMAS file dialog window offers a 

means of selecting a file type for conversion. The file extension is typically 

used to determine the file format, for example, the file extension spe is 

allocated to data saved in PHI Multipak format. 
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A new VAMAS file is created for each file selected via the dialog window and 

is written into the same directory as the original file. 

Displaying Data in CasaXPS 

One or more files may be selected via the file dialog. On pressing the Open 

button, a new experiment frame appears in the CasaXPS main window. 

 
Initially, the first row of data blocks are selected in the right-hand pane 

 
and displayed via a scrolled list of display tiles in the left-hand pane. 
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The keyboard arrow keys can be used to change the selection in the right-

hand pane. Each press of an arrow key moves the selection in the right-hand 

pane with respect to the data block displayed in the active tile in the left-

hand pane. Pressing an arrow key causes the newly selected data block to be 

displayed in the left-hand pane. 

 

Selection of Data using the Mouse 

Data blocks in the right-hand pane are selected using the mouse and a 

combination of the Shift key and the Control key. 

 

Left click the mouse over a data block in the right-hand pane to make a single 

selection. 

Extend the selection to a contiguous group of data blocks by holding the Shift 

key down before selecting a second data block using the left mouse button. 
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Add to the current selection by holding the Control key down before left-

clicking over a data block. 

 
Overlay the current selection of data blocks in the active tile by pressing the 

overlay toolbar button. 

 

 
Display the current selection one-per-tile using the display toolbar button. 

 

 

Tile Format 

Set the number of tiles-per page using the Page Tile Format dialog window. 
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Page tile formats are organized using predefined property pages for a 

number of tiles per page. Adjustments to the tile format involve choosing the 

tile alignment type. 

 
Specifying the number of rows (or columns): 

 
Specifying the number of tiles per row for each row enabled: 

 

Tile Display 

Each tile used to display data in the left-hand pane maintains a set of display 

settings. These display settings are adjusted using the Tile Display Parameter 

dialog window. Various fonts and colours used to draw spectra are adjusted 

via the property pages on the dialog window. 
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The tile in the left-hand pane with the title highlighted is the active tile. On 

pressing the toolbar button for the Tile Display Parameters dialog window, 

the settings entered onto the property pages correspond to the display 

settings for the active tile. When the OK or Apply button is pressed on the 

dialog window, the display settings for the active tile are updated. 

 
Data displayed in the active tile is indicated in the right-hand pane by a red 

border around the corresponding data block. The background for the data 

block in the active tile is also filled with a light yellow colour. 

Zooming into Data 

Changing the energy and intensity ranges for a spectrum is achieved using 

the mouse to draw a zoom box over the data currently displayed in the active 

tile. A zoom box is drawn over the data by holding down the left-hand mouse 

button whilst moving the cursor over the spectrum in the active tile. On 

releasing the mouse button, the drag box becomes a solid box over the data 

marking the energy limits and also the intensity limits over which it is desired 

to view the data. 
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To perform the zoom action, left-click inside the zoom box or press the zoom 

in toolbar button on the second toolbar. 

 
Each time a zoom action is performed, the parameters from the zoom box is 

placed on a zoom list. Following a sequence of zoom actions, the set of zoom 

states on the zoom list can be reviewed by pressing the zoom out toolbar 

button. 

 
 Each time the zoom out button is pressed, the previous energy and intensity 

ranges defined by zoom boxes are reinstated sequentially until the initial 

display ranges first used to view the data are recovered. Further pressing of 

the zoom out button will cause the zoom list to cycle from the initial zoom 

state. 

The zoom list is re-initialised by pressing the reset toolbar button: 

 

 If the data are prepared with quantification regions, pressing the reset 

button loads the zoom list with the quantification region limits. To view a set 

of peaks on a survey spectrum for which regions are defined, simply press the 

reset button followed by the zoom out button. 

Reset 

 

 

Zoom out 
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Loads regions Step to region 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Return to the initial display state. 

Zooming into a zone based on the mouse may require further adjustments to 

the display to achieve the desired perspective of the data. Further intensity 

scaling and positioning of the data with respect to the energy axis are 

achieved using the toolbar buttons: 

 
 Adjustments to the energy interval accompanied by rescaling of the intensity 

with respect to the data within the energy interval are performed using the 

toolbar buttons on the second toolbar: 
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Drag zoom box over 

data of interest. 

 

Zoom in 

 
Or 

Left-click inside zoom 

box. 

 

 

Step right 

 

 

 

Energy interval shifted 

by half the display width. 

Rescaling using the data within the current energy interval is achieved using 

the toolbar buttons: 

 

Processing Spectra 

Processing spectra is performed using options on the Spectrum Processing 

dialog window. The Spectrum processing dialog window is invoked from the 

Options menu or the top toolbar. 
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The Processing History property page lists the processing currently 

contributing to the state of the data displayed in the active tile. Other 

property pages offer processing options such as charge compensation and 

data smoothing. 

Basic Energy Calibration 

Shifting the energy scale to allow for sample charging is performed on the 

Calibration property page: 

 
There are many powerful methods for charge compensating data located in 

many different files or sets of data within the same file, for example a depth 

profile. Only the basic charge compensation is described here. 

Essentially, charge compensation is performed by specifying the location of a 

peak in the data as recorded. The measured location of the peak is associated 

with the desired true location of the peak, from which the necessary shift is 
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determined. The calculated shift may be applied to one or more spectra as 

appropriate. 

Charge Compensation for a Set of High Resolution Spectra 

Display the spectrum for which a peak position is known: 

 
Using the mouse, left-click the cursor on the peak as displayed in the active 

tile. The energy identified by the cursor position is updated in the Measured 

text-field on the Calibration property page. 

 
Enter the known value for the peak position in the True text-field. 

 
If regions and/or components are defined on any of the VAMAS blocks for 

which charge compensation will be performed, tick the Region and 

Component tick boxes. 

 
Select those VAMAS blocks for which the charge compensation shift is 

appropriately specified by the data in the active tile. 
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Press the Apply to Selection button. 

 

Each VAMAS block selected in the right-hand pane of the experiment frame 

will be shifted using the energy difference computed from the Measured and 

True text-fields on the Calibration property page. 

Quantification of Spectra 

XPS quantification in terms of peak intensities is performed by assigning 

quantification regions and/or peak models containing synthetic components. 

Quantification in CasaXPS is performed using the Quantification Parameters 

dialog window where the Regions, Components and Report Spec property 

pages are central to preparing and extracting quantification information from 

the data. 

 

Creating Backgrounds and Regions 

Quantification regions are energy intervals over which a background to the 

peaks is defined. 
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A region is defined using the Regions property page where each region 

appears as a column of parameters in a scrolled list. 

 

Each column in the scrolled list is divided into editable parameters and 

quantities computed for the region defined by the parameters. 
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To edit a region parameter, left-click the mouse over the value displayed on 

the table on the Regions property page. 

 
The value modified within the edit text field is only accepted when the enter 

key is pressed on the keyboard. Before pressing the enter-key, left-clicking 

the mouse away from the edit field causes the previous value to be 

reinstated. 

Regions are defined in terms of a regions name: 

 
Region names are user-defined names used to reference the information 

determined from the region. Quantification tables typically include the region 

name and more importantly quantities calculated from a region are specified 

within custom reports using the names assigned to a region. 

A Relative Sensitivity Factor or RSF for a peak identified by a region is 

typically extracted from the element library, but may be adjusted using the 

RSF row. 

 

Atomic concentration tables are computed from the raw peak area divided 

by the RSF parameter. Other corrections to the raw peak area are also 

applied when determining the atomic concentration; however the 

instrumental independent correction used to relate the relative intensity of 

different photoelectric transitions for an element is encapsulated in the RSF. 

The start and end parameters define the energy interval over which a peak 

should be measured. 
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These energy limits define the point at which the background meets the 

recorded data. 

 
A range of background (BG) types are offered, the most commonly used 

types are linear, Shirley and Tougaard. 

 
Linear backgrounds are typically used for insulating materials, while steps in 

metallic data are modelled using a Shirley background. 
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The full set of background types can be selected via a dialog window invoked 

by holding the Control key down and left-clicking over the current BG-type 

setting before the parameter is an edit field. 

 
A new background is selected from the list on the dialog window and is 

loaded into the BG type text field when the OK button is pressed. To accept 

the selection of the background type, press the enter key on the keyboard. 

The BG type field may be typed into the edit-field as an abbreviation. The 

Ƴƻǎǘ ŎƻƳƳƻƴƭȅ ǳǎŜŘ .D ǘȅǇŜǎ ŀǊŜ ŜƴǘŜǊŜŘ ǳǎƛƴƎ άƭέ ŦƻǊ ƭƛƴŜŀǊΣ άǎέ ŦƻǊ {ƘƛǊƭŜȅ 

ŀƴŘ άǘέ ŦƻǊ ¢ƻǳƎŀŀǊŘΦ 

 

The background and spectrum meet at the two energy limits to the region. 

Due to noise in the data, the actual data channel corresponding to the region 

limits may not be most appropriate for defining the background intensity at 

these limits. The Av Width parameter specifies the number of data channels 

on either side of the data channel corresponding to the start energy or the 

end energy over which an average intensity is determined for the background 

at the limits. 
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When using the Av Width parameter there must be sufficient data channels 

to either side of both start and end limits before the background intensity is 

determined using an averaged intensity. The largest source for precision 

errors in XPS measurements is due to poorly defined background intensities. 

The use of an appropriate Av width for the level of noise in the data is 

important.  

Two additional parameters influence the intensity of the background at the 

region limits. The start offset and end offset provide a means of scaling the 

background intensity at the region limits. The value specified for these 

parameters represents a percentage drop from the initial intensity computed 

for the background intensity. 

 
The cross section and tag fields are for advanced uses and therefore are not 

discussed here. 

Quantification of Survey Spectrum using Regions 

The best route to creating quantification regions is via the Element Library 

dialog window. The advantage of using the element library lies in the direct 

link between specifying the peaks and the RSF scaling information from the 

library. The simplest route to creating quantification regions is via the Find 

Peak/Create Regions buttons on the element table property page. 
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Regions are created via the Create Regions button for all those features on a 

spectrum for which: 

1. An element marker from the element library is active. 

2. A feature within the data can be identified. 

3. The RSF is the largest or the transition is explicitly selected for use via 

the CasaXPS_quant.lib configuration file. 

Using the element library dialog window , the first step is therefore to 

enable element markers for all the appropriate species within the data. The 

manual route to enabling element markers involves the element table, the 

left-hand pane and the mouse. With the Element Table property page top-

most on the Element Library dialog window, left-click the mouse with the 

cursor pointing at a peak in the data. The element table scrolls to display 

those transitions with energies around the energy indicated by the mouse. 

Select the most likely transition from the table on the Element Table using 

the name field. 

 



CasaXPS Manual 2.3.15 Rev 1.0  Copyright © 2009 Casa Software Ltd 
 

27 
 

Element markers are placed on the data for all transitions in the element 

table from the indicated element. The process is repeated for each peak in 

the data until all peaks are assigned to element markers. 
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Regions are created based on the proximity of element markers to the peaks 

in the data. In the event the energy scale needs calibrating, the calibration 

step should be performed before attempting to create regions. 

To calibrate the energy scale for an individual spectrum: 

Select the Spectrum processing dialog window 

 
Select the Calibration property page 

 
Left click the cursor pointing at the peak maximum of an appropriate peak in 

the left-hand pane and enter the True energy for the indicated peak. 

 
Press the Apply button to calibrate the spectrum in the active tile. 
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Provided the peaks are within a tolerance of the element markers and the 

peaks of interest are accounted for by the element markers, pressing the 

Create Regions button on the Element Table property page will create a set 

of regions on the spectrum. 

 

An annotation table offering a quantification table is added to the spectrum. 

 

The element markers used to identify and link the peaks to transitions in the 

element library may be removed from the display by pressing the Clear All 

Elements button on the Element Table property page. 

 

The quantification table may be repositioned on the data using the 

Annotation History property page. 
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With the Annotation History property page top-most on the Annotation 

dialog window, a small box appears above the top left-hand corner of the 

annotation table. 

 

Pointing at the centre of the small box then dragging the mouse causes the 

annotation to move to a new position the moment the mouse button is 

released. Other adjustments to the intensity scale for display purposes can be 

made using toolbar buttons. 

 
It is also advisable to check the quantification regions created automatically 

on the data. The zoom options described above provide a means of 

systematically stepping through the current list of quantification regions. If 

the Regions property page on the Quantification Parameters dialog window is 

top-most, stepping through the set of regions using the zoom options allows 
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the limits for the regions to be visually inspected and adjusted under mouse 

control. 

Adjusting the limits for a region under mouse control involves using the 

mouse to drag a limit to a new position. Region limits can be adjusted under 

mouse control only when the Region property page is top-most on the 

Quantification Parameters dialog window. A grey vertical zone indicates that 

the mouse is active with respect to adjusting the region end points. 

 

Following an adjustment to the limits, the annotation table and Regions 

property page are updated with the start and/or end energies defined by the 

cursor. 

 



CasaXPS Manual 2.3.15 Rev 1.0  Copyright © 2009 Casa Software Ltd 
 

32 
 

Manual Creation of Regions 

Regions created based on element markers require an identifiable peak to 

exist. If no such feature is located near the element markers no region is 

created for the element in question. Under these circumstances manual 

creation of regions is appropriate. While a Create button is available on the 

Regions property page of the Quantification Parameters dialog window, 

peaks from a survey spectrum have no means of assignment to transitions; 

therefore the Element Table property page includes a feature for manually 

creating regions specified via the name field in the element table. 

To create regions one at a time: 

1. Invoke the Quantification Parameters dialog window and ensure the 

Regions property page is top most 

2. Tick the box on the Element Library dialog window on the Element 

Table property page labelled Create When Line Selected. 

3. In the active tile, zoom the display to the energy interval about the 

transition for which a region is required. 

4. Left click the name field on the Element Table appropriate for the 

transition. 
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Adjust the start and end limits using the mouse or otherwise position the 

region appropriately for the transition selected. 

 

Creating Peak Models 

Constructing a peak model requires the definition of a background using the 

Regions property page and the introduction of synthetic component peaks 

via the Components property page. 

The Regions property page is used to define a background to the data 

envelope. 

 
The intensity from a quantification region can be explicitly excluded from a 

quantification report by entering an RSF of zero. 



CasaXPS Manual 2.3.15 Rev 1.0  Copyright © 2009 Casa Software Ltd 
 

34 
 

 
The function of the region is to define the background only allowing the 

intensities from the synthetic components to estimate the sample 

composition. 

Components are created using the Element Table property page in an 

analogous way to the method for creating individual regions. Left-click the 

mouse with the cursor over a peak as displayed in the left-hand pane. The 

Element Table scrolled list changes to display those transitions around the 

energy indicated by the cursor. 

 
Tick the box on the Element Table property page labelled Create When Line 

Selected. With the Components property page top-most on the 

Quantification Parameters dialog window, left-click the appropriate name 

field within the element table for the transition identified in the left-hand 

pane. 

 



CasaXPS Manual 2.3.15 Rev 1.0  Copyright © 2009 Casa Software Ltd 
 

35 
 

A peak is added to the display and the Component property page is updated. 

 

New peaks are added to the data where the residual is the greatest. The new 

peak is therefore unlikely to appear in the correct position with respect to 

the peak envelope. Using the mouse, point at the peak maximum for the 

newly created peak and drag the cursor to the appropriate position for the 

synthetic component. 

 

Repeat the process for each peak believed to be part of the model. 
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The example involves two elements and potentially five chemical states: one 

chemical state for the potassium and four for the carbon data. The two 

potassium peaks are part of a double pair; therefore the RSF for the 

combined pair of peaks is used when quantification is performed. 

While it would be possible at this stage in the peak modelling process to 

press the Fit Component button on the Component property page, the 

number of peaks and level of noise in the data suggests that constraints will 
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be required to achieve a valid physical description based on non-linear least 

squares peak fitting. 

A peak model is defined in terms of a name field and RSF serving exactly the 

same function as the name and RSF fields for regions. Fields specific to 

components are the line-shape parameter and the three parameters for area, 

position and full width at half maximum (FWHM) of the synthetic 

component. The parameters determined in a least squares sense are the 

area, position and FWHM. Constraints are available for restricting the 

possible values for these parameters during optimisation. 

 
Constraints take two forms: 

1. Parameter intervals offering a range of acceptable values for each 

parameter adjusted during a least squares optimisation. 

2. Relational constraints between parameters from different 

components. 

An interval is specified as a pair of numerical values separated by a comma: 

 
Relational constraints involve specifying a parameter as related to a 

parameter from a second component in terms of an offset or a factor. For 
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example, the area ratio of two peaks from a p-orbital doublet pair is in theory 

2:1. To impose this theoretical relationship for a potassium doublet, for 

example, the following constraint forces the 2p3/2 peak to be twice the size of 

the 2p1/2 peak: 

 
Relational constraints are defined in terms of the column header letters, thus 

to force the area of the peak in column A to be half the area of the peak in 

ŎƻƭǳƳƴ .Σ ǘƘŜ ŎƻƴǎǘǊŀƛƴǘ ŜƴǘŜǊŜŘ ƛƴ ŎƻƭǳƳƴ ! ƛǎ ά.ϝлΦрέΦ {ƛƳƛƭŀǊƭȅΣ ǘƘŜ C²Ia 

can be defined as a factor constraint, while a position constraint is defined in 

terms of an offset to a second parameter. 

 

Line Shapes 

CasaXPS offers many different functional forms for synthetic components. 

The line-shapes are specified using strings entered into the line-shape field 

on the Components property page. Line-shapes are described in detail 

elsewhere in the CasaXPS manual; however the most commonly used 

synthetic line shapes are product Gaussian-Lorentzian GL(m) and sum 

Gaussian-Lorentzian SGL(m), where m=0 is a pure Gaussian and m=100 is a 

pure Lorentzian shape. 
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The line-shape LA(a,b,n) offers asymmetric line-shapes based on the 

Lorentzian functional form convoluted with a Gaussian. 

A useful means of monitoring complex peak models is via a components 

annotation table displayed over the data. 

 

 

Exporting Peak Models as Data 
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Peak model data are exported via the clipboard. Display the VAMAS block for 

which a peak model is prepared in the active tile and press the toolbar 

button. A clip board selection dialog offering a table of data, where the table 

includes columns for binding energy, kinetic energy, spectral data in CPS, 

component data, the background intensities and the total synthetic 

envelope. These data can be saved as a TAB spaced ASCII file or copied onto 

the clipboard and pasted into software capable of accepting text data 

through the clipboard. 

 

Quantification using Standard Reports 

Quantification reports are text-based information generated from 

quantification regions and/or components defined on VAMAS blocks. The 

most common form for a quantification report is a tabulation of atomic 

concentrations calculated from regions on survey spectra. 
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The Report Spec property page on the Quantification Parameters dialog 

window provides the means of creating quantification reports from VAMAS 

blocks selected in the right-hand pane of the experiment frame. Creating a 

quantification table from regions on a survey spectrum involves: 

1. Defining a configuration file. 

2. Selecting the VAMAS block in the right-hand pane of the experiment 

frame. 

3. Pressing the Region button in the Standard Report section of the 

Report Spec property page. 

 
The configuration files for the Standard Report section are a set of ASCII files 

located in the CasaXPS.DEF directory. These configuration files contain 

keywords, one per line, specifying the type of information included in the 

columns of the text base report. The configuration file for the Standard 

Report Regions button is called RegionQuantTable.txt. 

 
The keywords listed in the file RegionQuantTable.txt are used to arrange the 

columns of the quantification report provided the Use Config File tick-box is 

ticked. 
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Selecting the VAMAS block in the right-hand pane before pressing the Region 

button causes a new view into the experiment frame to appear within the 

CasaXPS window. 

 

 
The quantification table displayed in the new window can be copied through 

the clipboard or saved to disk by pressing the Copy toolbar button. Once on 

the clipboard, any program capable of accepting text from the clipboard may 

receive the data by requesting a paste action (usually Control-V). 
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To return to the experiment frame displaying the spectra either switch 

windows via the Window menu of CasaXPS or close the text report window. 

 
Similar configuration files are available for configuring reports for each of the 

buttons in the Standard Report Section. 

Transferring Regions and Components to other Data 

Depth profiles are just one example of data sets where quantification 

information needs to be propagated throughout a set of similar spectra. The 

techniques described below are equally applicable to data from a range of 

experiments and apply to data spread over many VAMAS files as it does for 

data collected into a single experiment frame. 

The propagation of quantification information to other spectra will be 

discussed using an example of a depth profile performed on a multi-layer 

material. 

 
The data set consists of a set of survey spectra measured following a 

sequence of etch cycles. To examine the change in composition with etch 

time, the survey spectra require quantification regions appropriate for the 

entire set of spectra. Ultimately, each spectrum in the profile will have 
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regions defined on it and therefore minor adjustments on a spectrum-by-

spectrum basis are possible; however to obtain a reasonably good initial set 

of regions, the spectra are overlaid in the active tile so that all variations of 

the peaks can be assessed whilst defining the regions. 

Create a region for each line in the survey spectrum representative of the 

elements present. First create a region for the O 1s peak using the element 

table method described above. Two chemical states of oxygen are clearly 

present in the data; however a single region will monitor the amount of 

oxygen in the profiled material. 

 
Zoom into the Ti 2p peak envelope and add a region to measure titanium 

based on the Ti 2p peaks. 

 
Similarly add regions for carbon and silicon. 
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The regions as the data stands are all defined on the first spectrum displayed 

in the active tile. The next task is therefore to propagate the regions from the 

first spectrum to the remaining set of spectra. 

Ensure the spectrum for which the regions are defined is displayed in the 

active tile in the left-hand pane. 

 

Select the set of survey spectra in the right-hand pane. 

 

Move the cursor over the active tile displaying the spectrum for which the 

regions are defined and right-click the mouse. A Browser Operations dialog 

window lists the set of selected VAMAS blocks. Tick the Regions tick-box in 

the Propagate sections and press the OK button. 
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A progress dialog may appear briefly and on completion, the regions are 

transferred to the selected VAMAS blocks. 

 

The objective for a depth profile is to display the variation of the signal as a 

function of depth. For this example, the depth will be measured in terms of 

etch-time; nevertheless, the type of report required to produce the profile 

differs from the format obtained from the Standard Report. To generate a 

profile as a function of time, the Custom Report section on the Report Spec 

property page is employed. 
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The custom report is designed for profiling experiments. The set of 

quantification items (regions and components) defined on the selected 

VAMAS blocks are listed in the Quantification Item Names table. From these 

quantification item names a set of named formulae are prepared. 

NB: The name fields are used to define the relationships between the 

intensities in a profile. A special relationship is automatically applied to any 

quantification items assigned the same name. Specifically, if two 

quantification items have the same name then the intensity for the items 

with the same name are added together. It is therefore very important to 

name regions and components with different names whenever a custom 

report is used. 

Since the current example includes only regions, pressing the Region button 

transfers the region names into the table of names and formulae. 

 



CasaXPS Manual 2.3.15 Rev 1.0  Copyright © 2009 Casa Software Ltd 
 

48 
 

On pressing the Apply button in the Custom Report section, a column 

orientated quantification report is generated. 

 
The text based report may be transferred through the clipboard to other 

programs or plotted within CasaXPS either as a separate file or appended to 

the current VAMAS file. Appending the profile data to the current file allows 

cross referencing the profile to the spectra. Both options are available on the 

File menu offered when the profile is tabulated. 

Choosing the Add Profile menu option on the File menu adds the profile data 

to the original spectra as a temporary additional VAMAS file. The presence of 

a profile file is indicated in the bottom left-hand corner of the active tile. 
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To switch between viewing the spectra and the profile derived from the 

spectra, press Control-F8 on the keyboard. The profile view of the data set 

can be used to mark a set of etch times using a cursor drag-action coupled 

with holding the Shift Key down; on switching the display to the spectra using 

Control-F8, the set of etch times marked by the cursor become selected. 

Similarly, a contiguous selection in the spectrum view will determine the 

location of a cursor on the profile view of the data. 

 

Copying Data to a New Experiment Frame 

The depth profile VAMAS file continues to only contain the spectral data 

even after the Add Profile menu option is applied. To preserve a profile the 

VAMAS blocks containing the profile traces must be copied to a new 

experiment frame. The new experiment frame can be saved once populated 

with the profile VAMAS blocks. To copy VAMAS blocks between experiment 

frames: 

1. Select the VAMAS blocks in the right-hand pane. 

2. Either, create a new experiment frame using the File menu or toolbar 

button, or switch focus to an existing experiment frame. 

3. Press the Copy and Paste VAMAS blocks toolbar button. 

4. Press the OK button on the Copy Selected VAMAS blocks dialog 

window. 
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The new experiment frame contains a copy of the VAMAS blocks. 

 

Annotating Spectra 

Text and tables are added to spectra via the Annotation dialog window. 
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Text may be added to the display as individual items of annotation. Each 

piece of annotation appears in a list on the Annotation History dialog 

window. The list allows the annotation items to be selected, amended and 

deleted using the options on the Annotation History property page.  

The position of the annotation on the display is indicated by a small box next 

to the annotation text. Pointing the cursor at the box and dragging the cursor 

to a new position causes the annotation to move the moment the mouse 

button is released. 

 

Modifying a piece of annotation involves selecting the annotation in the 

Annotation History list. 

 
To alter the font, press the Font button and choose a new font for the 

selected annotation item. 
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Press the OK button on the Font dialog window and then press the Apply 

button on the Annotation History property page. 

 
To adjust a specific annotation item, left-click the box located next to the 

annotation on the display. As a result, the annotation item is to move to the 

top of the list on the Annotation History property page. 

Initially Ce LMM text is not visible in the scrolled list without scrolling through 

the list. 
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Left click the box beneath the Ce LMM annotation text on the display in the 

left-hand pane. Clicking the box causes the annotation item to move to the 

top of the list. 

 
Select the Ce LMM item on the Annotation History property page. To make 

the annotation horizontal rather than appearing in the initial vertical 

orientation, un-tick the Vertical Text tick-box and press the Apply button. 
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Auger Spectroscopy 

Auger peaks in an energy spectrum are an indirect consequence of the 

excitation of core level electrons. Subsequent relaxation of the excited state 

induced by the interactions of a primary electron with an atom may result in 

the emission of an electron with a characteristic energy. These Auger 

electrons appear superimposed on a background of secondary and 

backscattered electrons. 

 

The energy from the excitation source, typically an electron gun, alters the 

electronic state of an atom within the surface by ejecting a core level 

electron. The relaxation of the excited state occurs as a separate event from 

the core level excitation, so the characteristics of the excitation source have 

no influence on the energy with which Auger electrons are ejected from the 

surface. Auger electrons for an atom in a given chemical state always have 

the same energy regardless of the energy imparted by the primary electron 

beam or even when excited by other means such as x-rays. An oxygen Auger 

line, O KLL for example, appears at the same kinetic energy in a spectrum for 

both electron bombardment induced Auger or XPS induced Auger, regardless 

of the anode material in the x-ray gun. 

 
Thanks to Tyne R. Johns of Sandia National Laboratories for her assistance in editing this manuscript. 
Data used in the preparation of this text are kindly provided by: 
Prof Bridget Rodgers (Vanderbilt University) 
Tyne R. Johns (Sandia National Laboratories) 
Data provided courtesy of Sandia National Laboratories.  All rights in the data are reserved by the US Government.  Neither the US Government nor Sandia 
Corporation makes any warranty, express or implied, or assumes any liability with respect to the use of these data, and publication of these data does not 
constitute express or implied endorsement of any kind. 
RBD Instruments Inc. 
IFOS, Kaiserslautern , Germany 
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Auger peak intensities do depend on the excitation source and therefore 

Auger element libraries must include relative sensitivity factors for the 

specific electron gun energy used to excite the surface material. 

The Auger mechanism involves exciting a core electron followed by the decay 

of an outer electron to fill the core level. The new electron configuration is 

energetically unstable and results in the emission of energy by ejecting an 

electron with an energy characteristic of the intermediate states. These 

Auger transitions are often labelled using the letters assigned to the principal 

quantum numbers for the electronic shells: K, L, M, N, ... with subscripts 

differentiating the sub-shell structure. 
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For a more complete description of the Auger mechanism see Briggs and 

Grant ISBN 1 901019 04 7. 

Auger Electron Spectroscopy (AES) is performed using a Concentric 

Hemispherical Analyser (CHA or HSA) or a Cylindrical Mirror Analyser (CMA). 

The AES technique is offered in a stand-alone form and also as a multi-

technique instrument, often including XPS to complement the advantages of 

AES. Sub-micron spatial resolution requires a means of isolating vibrations 

and Mu-metal shielding from stray electric and magnetic fields.  

 
The following is concerned with spectra acquired using a CHA operating in 

fixed retard ratio mode or a CMA. 

Quantification of AES Data 

The acquisition mode for AES data determines the characteristics of the 

spectra and hence the quantification of peak intensities. CHA instruments 

typically have a response as a function of kinetic energy which behaves as an 

inverse power of the kinetic energy 
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where the exponent n is typically in the range 0.5 to 1. Historically AES 

spectra are measured using a fixed retard ratio FRR mode for the CHA. The 

FRR mode records the number of electrons reaching the detector as the 

kinetic energy of the ejected electrons is stepped such that the ratio of the 

initial kinetic energy of the electron to the pass energy of the analyser is 

maintained as a constant during the acquisition. A consequence of using FRR 

mode is that the energy resolution of the data changes with kinetic energy so 

that at high kinetic energy where the response of the CHA is reduced, the 

energy width accepted by CHA increases; the signal accepted by the CHA for 

electrons emitted with higher kinetic energy is greater than for lower energy 

electrons. The resulting spectra are therefore more uniform in intensity over 

a wide energy range. In particular, the high yield of secondary electrons at 

low kinetic energies is attenuated by the FRR mode, thus protecting the 

detector system from excessive count rates. As a result of these practical 

considerations, AES data are more difficult to quantify in terms of peak areas, 

therefore the method used to quantify Auger spectra is to measure the 

intensity of a transition using a differentiated spectrum, determining the 

peak intensity by the difference in the positive and negative going derivative 

peak heights. 

 
The so called direct spectra, as recorded, must be numerically differentiated 

to provide the data in a form suitable for quantification in terms of peak to 

peak intensities. 
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Some instruments, in keeping with the past, acquire the data using hardware 

signal differentiation, which partially accounts for the quantification based on 

peak-to-peak intensities. Most AES spectra acquired from modern 

instruments are in direct mode and so must be numerically differentiated 

before quantification is performed. 

The energy window for a CMA instrument is proportional to the kinetic 

energy of the analysed electrons. The CMA acquisition characteristics are 

therefore equivalent to data acquired using a CHA in FRR mode. 

Differentiation of Spectra 

Differentiating data in which noise is a component requires the use of a more 

subtle approach than Newton-Cotes differentiation. A least squares approach 

attempts to mitigate the influence of noise on the resulting derivative. 

Savitzky-Golay Method 

Two options on the Spectrum Processing dialog window commonly used for 

smoothing of experimental data and the determination of derivatives are 

performed using the algorithm proposed by Savitzky and Golay (A. Savitzky 

and M. J. E. Golay, Anal. Chem., 36, 1627 (1964)). The same algorithm is 

employed to differentiate spectra as is used to smooth data and therefore it 

should be clearly understood that the act of differentiating a spectrum using 

the Savitzky Golay method necessarily includes a smoothing operation. 
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Theory 

Given a set of data containing both signal and noise, the initial objective of 

the Savitzky-Golay method is to replace the raw data by a smoother set of 

data representing the true signal responsible for the record intensities. For a 

constant underlying signal, the most natural means of estimating the true 

signal from a set of measurements would be to average the values. The act of 

averaging a set of values is in fact one example and possibly the simplest 

applications of the linear-least-squares principle. Spectral data, on the other 

hand, typically contain peaks superimposed on a background signal and 

therefore a more subtle use of averaging is required if the essential structure 

in the data set is to be retained. One way to use the averaging process, but to 

maintain information relating to the variation in the intensities, is to perform 

a local averaging for each bin within a spectrum; for example, each data bin 

could be replaced by the average of three bins, the bin itself and the two bins 

on either side of the bin. The averaging operation could be applied to a data 

set via a digital convolution of the data bins with a convolution kernel 

consisting of the values {1/3, 1/3, 1/3}. These simple, yet often used concepts 

are at the basis of the Savitzky-Golay method, which in essence applies the 

least-squares principle to determine an improved set of kernel coefficients 

for use in a digital convolution, where these improved coefficients are 

determined, in the least-squares sense, using polynomials rather than, for 

the case of averaging, simply assuming a constant value determined from a 

sub-range of data bins. Indeed, the Savitzky-Golay method could be seen as a 

generalisation of averaging data, since averaging a sub-range of data 

corresponds to using a Savitzky-Golay polynomial of degree zero. 

To illustrate the Savitzky-Golay method, consider the specific example in 

which five data bins are used to approximate a quadratic polynomial. The 

polynomial can be expressed in the form: 

 

where the coefficients a0, a1 and a2 are determined from the simultaneous 

equations in which the abscissa x is the index for the data bin; the origin is 

always placed at the central data bin, thus the abscissa values corresponding 

to each of the data bins are {-2, -1, 0, 1, 2}: 
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or 

 

where the evenly spaced data bins {d-2, d-1, d0, d1, d2} are selected with the 

target of replacing the value for d0 with the value for the polynomial at x = 0 

or p(0) = a0. Since there are five equations and only three unknowns, the 

coefficients to the polynomial must be determined in the least-squares 

sense, where the linearly independent basis functions are 1, x and x2. The 

normal equations yield: 

 

Since ATA is a square symmetric matrix of rank three, the coefficient vector a 

is determined from [ATA]-1AT, the top row of which yields the prescription for 

computing the value of a0, namely: 

 

Thus, for each set of five such data bins, the central bin can be replaced by 

the value determined for a0. In other words, a digital convolution using the 

five point kernel {si} and the raw data bins results in a smoothed set of data 

bins, where a linear least squares quadratic polynomial is used to model the 

data, five channels at a time. 

Similarly, the derivative of a spectrum can be computed using the Savitzky-

Golay polynomial. Again the intention is to approximate the derivative at a 

given point in the spectrum using the derivative of the polynomial at x = 0. 

Since dp(0)/dx = a1, the second row of the matrix [ATA]-1AT yields a second 

convolution kernel for computing the derivative of the spectrum and, apart 

from the difference in the kernel values, the computation of the derivative 

proceeds in an analogous fashion to that of the smoothing calculation. 
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Creating Derivative Spectra for Peak-to-Peak 

Quantification 

Direct spectra are converted to differentiated spectra using the Spectrum 

Processing dialog window. 

 

 

The Differentiation property page on the Spectrum processing dialog 

provides a choice of two Savitzky Golay methods and a smoothing width 

value. The parameters used in the Savitzky Golay differentiation option 

depend on the source of the relative sensitivity factors used to quantify the 

data. For example, the set of RSFs in Appendix C of Briggs and Grant are 

designed for data acquired using an energy step size of 1 eV and 

differentiated using a 5 point quadratic Savitzky Golay differentiation 

method. Matching the acquisition step size and Savitzky Golay parameters is 

important because these influence the peak-to-peak height determined for 

an Auger peak. Consider a Gaussian peak with a FWHM of 7 eV tabulated at 1 

eV and 0.5 eV step-sizes: 
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If differentiated using a 5-point quadratic Savitzky Golay method the peak-to-

peak measurement for the same functional form differs by 10%. 

 
The FWHM used for the Gaussian is typical of an oxygen KLL peak. The scale 

of the difference between peak-to-peak intensities for peaks of different 

FWHM when measured using different step-sizes also varies. A peak-to-peak 

intensity for a peak with FWHM 10 eV when measured using 1 eV and 0.5 eV 

and differentiated using a 5-point Savitzky Golay method differs by 5%. 

The RSFs in Briggs and Grant are specified for a 4 eV energy interval 

numerical differentiation. In principle data acquired at 0.5 eV should 
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therefore be differentiated using a 9-point Savitzky Golay method, while data 

acquired at 1 eV would require a 5-point Savitzky Golay differentiation. While 

matching the number of points used in the Savitzky Golay method to the 

step-size can improve the acquisition step-size dependency, the test peak of 

FWHM 7 eV still results in a 1.8% difference in peak-to-peak height when 

tabulated at 0.5 eV steps and differentiated with a 9-point quadratic Savitzky 

Golay than when tabulated at 1 eV and differentiated with a 5-point 

quadratic method. 

Converting Direct Spectra to Differentiated Spectra 

To convert a spectrum from direct form to differentiated form: 

1. Display the spectrum in the active tile. 

 
2. Invoke the Spectrum Processing dialog window and select the 

Differentiation property page. 

 
3. For data acquired using 1 eV step-size, select the SG Quadratic radio 

button and enter 5 into the smoothing width text box. 
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4. Press the Apply button on the Differentiation property page. 

 
An entry appears in the scrolled list on the Processing History property page. 

 
Only the spectrum in the active tile is affected by the Differentiation property 

page. When other spectra are included in the experiment and also require 

differentiation, the processing performed on the spectrum in the active tile 

can be propagated to data selected in the right-hand panes of the 

experiment frame as follows: 

1. Display a spectrum in the active tile for which the differentiation 

operation is already performed and the Processing History property 

page displays the text string for the differentiation instruction (e.g. Diff 

SG D(2) P(5)). 
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2. Select the data blocks in the right-hand pane for which the 

differentiation operation is also required. 

 
3. Place the cursor over the active tile in the left-hand pane and invoke 

the Browser Operations dialog window by right-click the mouse 

button. 

 
The Browser Operations dialog window lists those VAMAS blocks selected in 

the right-hand pane of the experiment frame and offers a set of tick-boxes 

which specify the type of information to be propagated from the VAMAS 


